Welcome From The Chief Editor
October looks to be a HUGE month for Linux. And I do mean HUGE! For years, Windows users' largest complaint against Linux (really, an excuse for not using Linux) was the perception of Linux not being a good gaming platform. But with the support of ONE major player, Linux will rush to the forefront of the gaming community.
Yes, I’m talking about Steam for Linux, which is scheduled to be released in October, 2012. In July, Valve head Gabe Newell stated that one reason for the focus on Linux is because “Windows 8 will be a catastrophe for everyone in PC space.”
Just the October 26th release date for the much maligned Windows 8 is reason enough to give Linux users reason to celebrate. That alone will be cause for many Windows users to explore alternative operating systems, and Linux distros all across the Linux landscape can expect a steady influx of new users.
Now, with Valve bringing Steam to Linux, the last “obstacle” to Linux adoption appears to be surmounted. In fact, some of the early reports coming from Valve and a bevy of beta testers indicate that many games run faster and leaner under Linux OpenGL than they do under Windows DirectX. They also report the the conversion of many of the Windows-only games is going much easier and faster than they anticipated.

As a result, it will be important for current Linux users – PCLinuxOS users included – to be prepared for an influx of new users. With that influx, comes the usual host of new user questions, many that we user's of Linux have already had to deal with. We can and should be welcoming to those new users, patiently answering those endless streams of questions that we've all answered a million times before.
Those new users – those ex-Windows users – have to be shown a new, better way of doing things. Many are not accustomed to using forums as their primary support channel. Most are used to finding and downloading applications from the web, as opposed to installing applications from a central repository where all the applications work together without breaking other installed applications. Whether those users stay or go largely depends on how welcoming their reception is and how much help they receive. We all have heard of how good PCLinuxOS is for users making the transition from Windows to Linux. By welcoming and helping those ex-Windows users, we can help see the numbers of PCLinuxOS users grow.
Above all, we must remember that we were all once as they are – new to Linux. Thankfully, the PCLinuxOS forum is a place where "RTFM" isn't typically spoken, as is done all too frequently in other Linux forums. By putting forth a friendlier hand and a more helpful hand, let's hope those new users choose to remain PCLinuxOS users.
Until next month, I bid you peace, serenity, happiness and prosperity.
October Is Breast Cancer Awareness Month
by parnote & meemaw
In some way, everyone knows someone that breast cancer has touched. If not directly, then they know a friend, family member, loved one, co-worker, acquaintance, or a family member or friend of any of the aforementioned who has had to deal with breast cancer.
Breast cancer, like most cancers, is largely a genetic disorder. The genetic link is attributed to familial history or genetic mutations. However, certain environmental exposures, as well as the degenerative effects of aging, have been shown to increase the chances of developing breast cancer later in life. Thanks to early detection, the “cure” rate for breast cancer has gone up significantly. Treatment includes surgery, pharmacological intervention, chemotherapy and focused irradiation of the cancerous cells, either by themselves or in combination.
Here are a few facts about breast cancer in the United States, from breastcancer.org:
A Little Closer To Home
A few PCLinuxOS forum members shared their personal accounts of dealing with breast cancer, below.
anonymous forum member
Breast cancer is something I'm acutely aware of every single day; I lost my oldest daughter to it in 2003. She was only 39 years old and it was horrible to watch her suffering. It was one of many similar experiences that have convinced me not to fight too hard when my time comes.
My sister had it just a few years ago when she was in her mid-50s, too, but has survived very well after radical mastectomy surgery and all the chemo, etc. Her husband just lost his sweet corporate job recently and thankfully pre-existing conditions are no longer a factor in medical insurance because she still has quite the regimen of drugs to take, and I hope the cancer never comes back but if it does, at least they'll be able to afford insurance until he lands another job.
My grandson is also a survivor of a brain tumor, although it was not cancerous, thankfully. He was diagnosed with it when he was 2, had a mass the size of an orange removed from deep in his head when he was 6, and now at the age of 12 he just got accepted into a local school for the performing arts. He is a goof-off but he's still my hero!
meemaw’s
I have a family friend whose wife had breast cancer several years ago, along with the awful mastectomy and reconstructive surgery. Another good friend’s wife had breast cancer about 20 years ago. Hers was better than most... having a “lump-ectomy” and taking chemo to make sure they got it all... she’s been cancer-free for a while.
Many different types of cancer exist, however. I also have a brother in remission and a brother-in-law in remission. They both had different types of lymphatic cancer. A nephew just finished radiation for throat cancer and the last scan was very good. A very wonderful family friend is still battling pancreatic cancer. We’re hoping for a good report after his next scan.
anonymous forum member
I have had three operations for skin cancer. The first one left me in the hospital for two months. The doctor cut out a large portion of my shoulder over the collarbone. He grafted skin from deceased donors onto the area, as well as a large slice he had taken out of my leg for the purpose. The second operation was for a malignant melanoma on my face. The VA hospital doctor had already operated to cut it out. She did not get it all, however. Now it was up to the doctor at the cancer clinic to finish the job. After two separate procedures the same day, the doctor announced he had removed all of the tumor. He had told me before the operation had ever been scheduled that I would need to undergo radiation treatments after the operation. My father had not long before died of lung cancer. In the end, it was the chemotherapy and radiation treatments that killed him. Although I had been reluctant to, I underwent radiation treatments over a three month period. I am still cancer free[a].
steve161
My uncle Harry was diagnosed with Pancreatic Cancer when he was in his early 60's. Within six months he went from a handsome, well-built man to weighing 90 pounds before he passed. I was able to visit him in Florida before he died, and it was so sad to see my favorite uncle accepting the inevitable. Hopefully, one day it will not be inevitable.
I also may add that my mom was diagnosed with breast cancer. It was quite the scare, but it was caught early. With good luck and a great team of doctors, she had a minor procedure (lumpectomy?), and the cancer never came back. 87 and still going strong.
raycleve
I was diagnosed with Prostate Cancer in 1998 and it was cured with radiation.
A couple of months ago I was found to have a large tumor in my bladder, My urologist said that at my age, 89, I could not survive an operation to remove the tumor. Since I had radiation for the Prostate Cancer they can not use radiation for the tumor. So far I have had 9 Chemo Therapy treatments. Last Tuesday I had a CT Scan. This Tuesday I will see the oncologist and find out if the Chemo has had any effect on the the tumor. and probably then have my 10th Chemo treatment.
My sister and brother both had cancer before they died and my father died of cancer at the age of 43.
gandy
About a year ago a friend and neighbor went to the Emergency Room after suffering stroke-like symptoms. He lost control of the left side of his body. They did x-rays of his brain and found a mass that turned out to be a malignant brain tumor. He has since lost the battle. He was 62.
Someone once said that "Life causes cancer". Despite the billions of dollars being spent, I'm not optimistic that medical science will ever win the war, at least in my lifetime. Then again, wars are won by winning battles and there have been battles won.
Find Out More About It
To help you find out more information about breast cancer or other types, check out these following resources:
National Cancer Institute at the National Institutes of Health
While the resources listed above are national and international in their scope and reach, don’t forget to look for local resources. There are many local resources available, many right in your own backyard. They are merely an Internet search away, via your favorite search engine.
A heartfelt thanks goes to every forum member who shared his/her story about this devastating illness. We appreciate your discussion of a very sensitive subject, and hope that talking about it has, in some way, helped to ease your pain.
Search The PCLinuxOS Repositories From The Command Line
by AndrzejL
How many times were you asked “Do you have package XYZ in the repositories?“ Sometimes you know the answer, and you will be able to say “Yes we do coz I am using it.“ Sometimes however, you just don’t know. So you open synaptic and search for the package name. But what if there is MUCH quicker way?
Well, there is a much quicker way. Open up your favorite terminal, and enter the following on the command line:
apt-cache search packagename

This is also the way to find out the proper name of the package in case of installing from the command line … without access to Synaptic.
If you want to make sure that you are searching amongst the most recent packages in the repository you may want to run this command before searching:
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aaphoto Makes Your Photos A+
by Paul Arnote (parnote)
Deep in the recesses of the PCLinuxOS repository, unassumingly and quietly tucked into the long list of available applications, there’s a little hidden gem, just waiting to be uncovered. When you rub and shine and polish this gem, it will take your photos and make them even better.
Well, that may be going a little far, but aaphoto can work magic on your photos that have suffered from improper exposure or bad lighting conditions. In short, it can take many of your previously unusable photos and make them usable. Let me show you.
The aaphoto application is a small (112 KiB) command line utility, so you will need to know a little bit about running an application from the command line in a terminal session. But don’t worry – it’s not hard.
Currently up to version 0.41, aaphoto is written by Andras Horvath, from Hungary, and is undergoing active development. The most current version (and the version available in the PCLinuxOS repository) was released on June 12, 2011. The application is cross platform, written for Linux, FreeBSD and Windows. Here is the description of aaphoto, from Synaptic:
aaPhoto (CLI) (Auto Adjust Photo) corrects the colors of the image and generates a new image file on the disk. Two main functions: automatic color correction and resizing!
The program tries to give a solution for the automatic color correction of photos. This means setting the contrast, color balance, saturation and gamma levels of the image by analization.
This can be a solution for those kind of users who are not able to manage and correct images with complicated graphical softwares, or just simply don't intend to spend a lot of time with manually correcting the images one-by-one.
The program handles the following image formats: mif, pnm/pgm / ppm, bmp, ras, jp2, jpc, jpg, png.
Service menus for KDE4 are integrated, but the command line offers more options.
As with most command line tools, aaphoto is controlled by a host of command line switches. The following options are supported:
-h --help Print this help
-v --version Print version information
-a --autoadjust Auto adjust the colors of the image
-o --output Set output directory
--overwrite Overwrite mode, the original source file is replaced
(Not recommended! NEVER EVER overwrite an original file, if you can avoid it!)
--jpg JPEG image output
--jp2 JPEG 2000 image output
--png PNG image output with alpha channel support
--bmp BMP image output
-r --resize Resize image taking the longer side in % or pixels
--rotate90 Rotate image with 90 degrees clockwise
--rotate180 Rotate image with 180 degrees
--rotate270 Rotate image with 90 degrees counter-clockwise
--flipx Mirror image horizontally
--flipy Mirror image vertically
--noexif Save image without EXIF info
-q --quality Set image quality from 1 to 100
-t --threads Set number of working threads (default: autodetect)
-s --silent Silent mode, no information printed during operation
--quiet ...same as above
-V --verbose Print verbose information about processing
--test Print detailed test information into image
The order of the command line switches is NOT important. Just be sure that the source file (the filename of the image you are trying to improve) is the last thing listed on the command line. You can view the "help" for aaphoto at any time by entering aaphoto --help at a command line prompt in a terminal session, or you can view it on the web here. You can also visit the web homepage for aaphoto here, or visit the aaphoto wiki here. Note that the latter two pages are written in Hungarian, but Chromium browser offers to automatically translate them for you into your native language. There is an English language translation of the aaphoto homepage here.
Take a second to review the command line switches, and you will soon see that aaphoto does more than color correction of your photos. It will also rotate images, resize images, mirror images, set image quality, and strip EXIF information from your images. There may be other graphics manipulation applications that do more, but aaphoto does an admirable job with the tasks that it does cover. Plus, aaphoto does it fairly quickly.
The "magic" performed by aaphoto happens when aaphoto analyzes the histogram of the image, then tweaks various settings such as contrast, color balance, saturation and gamma levels.
Some examples
All this talk means nothing by itself, so let's see some examples of what aaphoto is capable of.
From one of my recent bicycle trips on my vacation in August, here is an image that – until I discovered aaphoto – was pretty much unusable.

Notice the haze across the image from shooting into the relatively low morning sun. The colors are all muted and a lot of the detail in the photo is lost.
Here is the same image, after running it through aaphoto.

You'll notice that there is still some lens flare in the upper right corner of the image, but now a lot of the haze is gone, and the colors are a lot more vivid. While not perfect, aaphoto has made the image usable, and restored the image to how I remember seeing the image in my mind. The aaphoto command line I used to improve the image is this:
aaphoto --png -a --rotate270 original_photo.jpg
The --png switch tells aaphoto to output the finished file as a PNG graphic file. The -a switch tells aaphoto to automatically correct the colors in the photo. The --rotate270 switch tells aaphoto to rotate the image 90 degrees counter-clockwise (or 270 degrees clockwise). Finally, the command line is ended with the name of the image I want to improve.
Here are some other images that aaphoto helped improve. The command line used is shown under the improved image.


aaphoto --png -a original_photo.jpg


aaphoto --png -a original_photo.jpg


aaphoto --png -a original_photo.jpg


aaphoto --png -a original_photo.jpg
In the last photo, the changes are subtle. In the original, my face took on a blueish hue, due to all the blue in the photo. In the "improved" image, the skin tones are improved, the amount of shadow under my PCLinuxOS hat has been reduced, and the colors are more vivid (like in the leaves and foliage behind me).
“Service Menus”
Under KDE4, some KDE service menus are installed when you install aaphoto. Unfortunately, the installed KDE service menus are of very limited use – unless you know how to write your own KDE service menus (and that is a topic for a whole 'nother article). Compared to the KDE service menus, you will find aaphoto to be much more useful when used from the command line.
Still, here is the installed service menus under KDE4:

As you can see, the KDE service menus leverage only a fraction of the capabilities of aaphoto. Mirror image as a service menu? I would have thought that the image resizing or image rotation functions would be much more useful additions to the service menu. I can't even think of the last time I had to mirror an image.
Fortunately, "service menus" are much easier to create for Thunar and Nautilus users – except that neither call them "service menus." Under Thunar, they are called "Custom Actions," and under Nautilus, they are called “Nautilus Scripts.”
Under Thunar’s Custom Actions, the aaphoto command will take the following form:
aaphoto --png -a -r600 %n
The above command will convert a single image image (%n) to a PNG file, auto correct the color, and resize it to 600 pixels wide (along its longest border). You can customize the command as you see fit, to include the command line options you desire. Just be sure to give each different command its own, unique name.
Under Nautilus, you can create a custom script, similar to the one below:
#!/bin/bash
while [ $# -gt 0 ]; do
picture=$1
aaphoto --png -a -r600 "$picture" "600-$picture"
shift
done
This Nautilus Script does exactly the same as the Thunar Custom Action above, but only on multiple files. Also, just as with the Thunar Custom actions above, you can alter this script to include the command line options you want. Also, give each script its own unique name.
Summary
As you can see, aaphoto comes in just short of working miracles on photos with skewed colors, either due to exposure or poor lighting conditions. Certainly, you will be able to find photos that aaphoto cannot resurrect and correct. But, in my experience, those instances are few and far between. Without a doubt, aaphoto is a very powerful tool that should be in every computer user's arsenal of graphics tools.
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Customize Squid Network Warnings On PCLinuxOS
by AndrzejL
I downloaded and configured Squid using PCLinuxOS Control Center.

All was well and everything was working just fine. However, I was receiving silly netmask warnings and some security notifications, such as those listed below:
[root@icsserver andrzejl]# service squid restart
Stopping squid: 2012/01/14 19:31:49| WARNING: Netmasks are deprecated. Please use CIDR masks instead.
2012/01/14 19:31:49| WARNING: IPv4 netmasks are particularly nasty when used to compare IPv6 to IPv4 ranges.
2012/01/14 19:31:49| WARNING: For now we will assume you meant to write /24
2012/01/14 19:31:49| aclIpParseIpData: WARNING: Netmask masks away part of the specified IP in ’192.168.0.1/255.255.255.0′
2012/01/14 19:31:49| ERROR: ’0.0.0.0/0.0.0.0′ needs to be replaced by the term ‘all’.
2012/01/14 19:31:49| SECURITY NOTICE: Overriding config setting. Using ‘all’ instead.
2012/01/14 19:31:49| WARNING: (B) ‘::/0′ is a subnetwork of (A) ‘::/0′
2012/01/14 19:31:49| WARNING: because of this ‘::/0′ is ignored to keep splay tree searching predictable
2012/01/14 19:31:49| WARNING: You should probably remove ‘::/0′ from the ACL named ‘all’
2012/01/14 19:31:49| WARNING: Netmasks are deprecated. Please use CIDR masks instead.
2012/01/14 19:31:49| WARNING: IPv4 netmasks are particularly nasty when used to compare IPv6 to IPv4 ranges.
2012/01/14 19:31:49| WARNING: For now we will assume you meant to write /32
…. [ OK ]
init_cache_dir … Starting squid: . [ OK ]
[root@icsserver andrzejl]#
Squid worked as expected but the annoying warnings would not let me forget about the whole thing. So I have decided to investigate.
As it turns out those are the errors that occur when you are using squid 3 with a squid 2 config file. PCLinuxOS has squid 3 in the repos.
[andrzejl@icsserver ~]$ rpm -qa | grep squid
squid-3.1.16-1pclos2011
[andrzejl@icsserver ~]$
But, the beginning of its config file says:
# WELCOME TO SQUID 2
This calls for a few changes in the squid config file, which in PCLinuxOS can be found here:
/etc/squid/squid.conf
First we have to find out what CIDR is. (Click on the link to read it for yourself). With this knowledge we can start editing squid config file as root.
This line:
acl mynetwork src 192.168.0.1/255.255.255.0
was changed to:
acl mynetwork src 192.168.0.0/24
and the number of warnings was reduced significantly:
[root@icsserver andrzejl]# service squid restart
Stopping squid: 2012/01/14 19:36:11| ERROR: ’0.0.0.0/0.0.0.0′ needs to be replaced by the term ‘all’.
2012/01/14 19:36:11| SECURITY NOTICE: Overriding config setting. Using ‘all’ instead.
2012/01/14 19:36:11| WARNING: (B) ‘::/0′ is a subnetwork of (A) ‘::/0′
2012/01/14 19:36:11| WARNING: because of this ‘::/0′ is ignored to keep splay tree searching predictable
2012/01/14 19:36:11| WARNING: You should probably remove ‘::/0′ from the ACL named ‘all’
2012/01/14 19:36:11| WARNING: Netmasks are deprecated. Please use CIDR masks instead.
2012/01/14 19:36:11| WARNING: IPv4 netmasks are particularly nasty when used to compare IPv6 to IPv4 ranges.
2012/01/14 19:36:11| WARNING: For now we will assume you meant to write /32
…. [ OK ]
init_cache_dir … Starting squid: . [ OK ]
[root@icsserver andrzejl]#
Next I removed this line:
acl all src 0.0.0.0/0.0.0.0
which is built into Squid anyway.
This reduced the warning messages even more:
[root@icsserver andrzejl]# service squid restart
Stopping squid: 2012/01/14 19:39:14| WARNING: Netmasks are deprecated. Please use CIDR masks instead.
2012/01/14 19:39:14| WARNING: IPv4 netmasks are particularly nasty when used to compare IPv6 to IPv4 ranges.
2012/01/14 19:39:14| WARNING: For now we will assume you meant to write /32
…. [ OK ]
init_cache_dir … Starting squid: . [ OK ]
[root@icsserver andrzejl]#
The final step was to edit this line:
acl localhost src 127.0.0.1/255.255.255.255
to read:
acl localhost src 127.0.0.1/32
After editing the config file, Squid is running without any warnings and everything is “peachy.”
[root@icsserver andrzejl]# service squid restart
Stopping squid: …. [ OK ]
init_cache_dir … Starting squid: . [ OK ]
[root@icsserver andrzejl]#
My config file contains few extra modifications. Please use it if you feel like it after editing it to reflect your network settings.
Graphics Tutorials: Gimp, Part 4
by Meemaw
One of the first tutorials I ever did was one from the Linux Graphics Users Forum. One of the members posted several neat ways to manipulate a photo and I’m going to share this one with you. I used a photo of flowers and did a Layer Mask. It creates an effect like the one shown below:

Choose a photo and open the image up in the Gimp. I chose this one:

Next, create a copy of the background layer by clicking on Copy Layer in the layer tools.
You can name your new layer something else if you want by right clicking the new layer and selecting Edit Layer Attributes... and change the layer name to mask or something else.
First, make the new layer invisible by clicking on the eye next to the layers thumbnail and name. When you click on it, the eye disappears.

Now click on the original layer, so that it's highlighted, which means that it's the layer you're working on. We’re going to make this layer black and white. You can use the Desaturate tool, but it will have better detail with the Channel mixer (Colors -> Components -> Channel mixer).

To get a B&W image, click the Monochrome checkbox. Now start moving the Red, Blue and Green controls back and forth and you'll notice that lower values make the image darker (or underexposed) and higher values make the image brighter (overexposed). The values to use have to be found by experimenting. There probably is a scientific explanation on how to do this, but play around with different settings and then see what you get. Every image is different so there isn't a setting that will give good results on all images. On this photo I had to be careful not to have Red or Green too high since it would make parts of the flower overexposed (too white, loss of detail). After clicking OK, I get this.

Finally, to really make the image 'pop' we need to use the Unsharp mask (Filters -> Enchance -> Unsharp mask) filter, that sharpens the image and also adds some contrast. The settings I used here are Radius 4.2, Amount .51, and Threshold 5. The screenshot doesn’t really show it, but the detail in the flower was better after the Unsharp mask than before.

Now click the eye again on the mask layer (the background copy we created), and also click on the layer so it's highlighted. You should now see the colored variant of the image again.
In the toolbar click Layer->Mask->Add Layer Mask in the pop-up window click Black (full transparency) and then click Add.
You should now see this in your Layers, Channels... window:

...and the image will be all black and white.
Now, we will start painting the color back. Make sure the mask layer is highlighted in the Layers, Channels... window. Make sure the mask itself (the black box in the layers toolbox) is highlighted. It will have a white frame.
Now select the Pencil tool.
Since the layer mask is black you must paint with white to get the original color back. The image above has white as the Foreground color
Using the pencil tool start painting the part of the image you want in color.

Change the size of the brush to have better control: a bigger brush for the middle parts and a smaller brush for finer ends of the petals. I changed the size of my pencil to 5 until I got the edges established. Use <Ctrl> + Z to undo it if you go outside the 'lines'. I’ve learned to make short strokes until I get the edges outlined so I won’t have so much to redo if I stray outside the area I’m changing. Zooming in on the image also helps. You can Use View... Zoom and change the zoom or hold down <Ctrl> on the keyboard and scroll the mouse wheel forward.
When you have it the way you want it, right-click the mask layer and select Apply layer mask then right-click the same layer again and select Merge down, then Export to a picture file.
You’re done!!!
My thanks to conholster on the Linux Graphics Users Forum for the two tuts I used.
http://linuxgraphicsusers.com/forum/?topic=505.0
http://linuxgraphicsusers.com/forum/index.php?topic=565.0
Create Your Own Custom KDE Service Menu
by Paul Arnote (parnote)
You are a KDE4 user. KDE’s Ark is your favorite file compression utility.You open Dolphin in KDE4, move into your “Downloads” directory, and select the latest *.zip file that you just downloaded, filled with pictures from your Uncle Ben’s vacation. You right click on the file and select “Extract Archive Here, Autodetect Subfolder” from the “Extract” menu on the Dolphin context menu. Tada! All of Uncle Ben’s vacation pictures are now in their own folder, ready for your viewing pleasure.

Welcome to the world of KDE service menus. In the language of KDE, that’s what they are called, anyways. Thunar has user definable custom actions built right in. Nautilus uses custom bash scripts, which it refers to as Nautilus scripts. Sorry PCManFM users, but PCManFM has not matured to the point of having customizable context menus, so you are out of luck when it comes to customization.
KDE defines service menus in .desktop files. While not particularly difficult to understand, the real chore is in figuring out where KDE keeps them stashed. There are a few places to look. All the locations are defined in the $KDEHOME environment variable. Instead of spending an eternity looking around for the location of where your “services” directories are located, just run the following command from a command line prompt in Konsole (or other favorite terminal):
kde4-config --path services
Mine happens to list two directories: /home/paul_lenovo/.kde4/share/kde4/services/ and /usr/share/kde4/services/. The differences are that the former directory lists “services” that are available only to me, as a solitary user, while the latter directory lists “services” that are available globally, to all users.
What Is A Service Menu?
Just as with many files in Linux, the .desktop files that define the KDE service menus are simple text files. Armed with your favorite text editor and an idea, you can easily create your own custom service menu. Before we can customize a KDE service menu, we must first understand what it is.
Here is the first part of the aaphoto.desktop file (located in /usr/share/kde4/services/) that adds the aaphoto service menus to Dolphin:
[Desktop Entry]
Type=Service
Name=aaphoto
Encoding=UTF-8
ServiceTypes=KonqPopupMenu/Plugin,image/*
Actions=Correction;FlipX;FlipY;
MimeType=mif;PNM;pgm;ppm;bmp;ras;JP2;JPC;jpg;jpeg;png
Icon=image-x-applix-graphics
X-KDE-Submenu=aaphoto
The first line specifies the “type” as a “Service.” The second line specifies the name for the service. In this case, it specifies “aaphoto” as the name for the top level menu entry in the file manager context menu. The third line specifies the encoding, typically UTF-8.The fourth line specifies the service type. Here, it is “KonqPopupMenu/Plugin,image/*”. Both Dolphin and Konqueror will utilize the same service menus.The fifth line specifies the actions that will be defined later in the aaphoto.desktop file.
The sixth line, “MimeType”, specifies what types of files the service menu is intended for. In the aaphoto.desktop file, this line lists all the image file types that aaphoto can work its magic on. If you want the service menu to be available for all file types, use “application/octet-stream” as the mime type. If you want the service menu to be active for use on directories, use “inode/directory” as the mime type. Separate multiple file types with a semicolon, and be careful to not include any spaces.
The seventh line, “Icon,” specifies just the name of the icon file to use to display next to the menu entry. There is no need to specify the file extension, but remember that the icon must exist in a directory in your path. The eighth line reiterates the name of the submenu to be inserted into the file manager context menu.
Now that we have the foundation laid, so to speak, it’s time to specify the individual actions in the service menu. Here are the individual actions, as they are defined in the aaphoto.desktop service menu file:
[Desktop Action Correction]
Name=Automatic photo adjusting
Name[de]=Automatische Foto Korrektur
Exec=aaphoto -a %f
Icon=image-x-applix-graphics
[Desktop Action FlipX]
Name=Mirror image horizontally
Name[de]=Bild spiegeln horizontal
Exec=aaphoto --flipx %f
Icon=image-x-applix-graphics
[Desktop Action FlipY]
Name=Mirror image vertically
Name[de]=Bild spiegeln vertikal
Exec=aaphoto --flipy %f
Icon=image-x-applix-graphics
Notice that each section begins with “Desktop Action” followed by the action that was specified in the first section of the aaphoto.desktop file – all enclosed in brackets. This part is case sensitive, so be careful to get capitalization correct.
Next, each section is assigned a “Name,” and this is the text that will appear in the aaphoto submenu. If you want to include multiple languages, specify each on its own line, starting with Name, followed by the two letter language code in brackets, then the text for that language. In our example above, there is the “Name[de]” line, for the German language. A line for the Spanish language would start with “Name[es]” and the Finnish language would be “Name[fi].” Continue on in this manner for each language you want to provide a translation for. You can find a list of all the two letter language codes here.
The third line of each desktop action section is where everything happens. The “Exec” line specifies the action to execute. In our case with the aaphoto.desktop file, it’s the execution of the aaphoto command line application, complete with the appropriate command line switches. Take notice of how the command ends with %f. Known as a “field code,” the %f passes a single filename to aaphoto, even though aaphoto can process a whole directory at once. Other “choices” might be %F (multiple files), %u (a single URL or file path), or %U (multiple URLs or file paths). You can view the entire list of recognized field codes here, from the freedesktop.org standards. Which field code you use is dependent on whether or not the application you’re calling requires filenames or URLs, and whether or not the application can process single or multiple files or URLs.
If you have a complex task that requires more than one command to be executed, the KDE developers recommend using a shell. For example, the “Exec” line in your .desktop file should read Exec=/bin/sh -c “;<YOUR COMMANDS HERE>” – or something similar.
Customizing The KDE Service Menu
As I mentioned in my article about aaphoto, the choices for the included KDE service menus is certainly WAY less than ideal. But armed with our new knowledge about KDE service menus, we can correct that entire situation, and give ourselves some KDE service menus that are actually useful.
For starters, let’s add service menus to the aaphoto.desktop file that rotate images. (NOTE: you can only edit the aaphoto.desktop file as the root user!) In the first part of the aaphoto.desktop file, let’s add Rotate90, Rotate180 and Rotate270 to the Actions entry (line 5). Your “Actions” entry should now read like this:
Actions=Correction;FlipX;FlipY;Rotate90;Rotate180;Rotate270
Now, add the following sections to the end of the aaphoto.desktop file:
[Desktop Action Rotate90]
Name=Rotate 90 Degrees
Exec=aaphoto --rotate90 %f
Icon=image-x-applix-graphics
[Desktop Action Rotate180]
Name=Rotate 180 Degrees
Exec=aaphoto --rotate180 %f
Icon=image-x-applix-graphics
[Desktop Action Rotate270]
Name=Rotate 270 Degrees
Exec=aaphoto --rotate270 %f
Icon=image-x-applix-graphics
Be sure to save the updated aaphoto.desktop file when you are done editing it. Once saved, you should be able to right click on any file type listed in the MimeType line and instantly have access to your new image rotation menus.
Just as easily, you can continue to add other tasks that aaphoto is capable of performing to the aaphoto KDE service menu. For example, you can add commands that resize images to specific sizes (e.g., aaphoto --png -r600 %f to output a PNG file and resize the long side of the image to 600 pixels). Rather than hold your hand through that process, I’m going to leave the addition of the other aaphoto commands for you to discover and figure out on your own.
Summary
I have to admit to having some kind of “block” when it came to creating KDE service menus. I had looked at them several times before a lightbulb went on and the entire process “clicked” in my brain. As you can see, they really aren’t all that difficult. But now that you know how to use and create them, you can now go forth and customize your KDE service menus to your heart’s content. The only limitation is your own imagination.
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AQEMU: A GUI for QEMU
by Patrick G Horneker (phorneker)
In previous articles on QEMU, I have shown you command line options for controlling QEMU. There are a number of utilities (downloadable from Synaptic) that provide a graphical interface for controlling of QEMU.
AQEMU is the subject of this article, and is a fully functional application that makes using QEMU easier.
To install AQEMU, launch Synaptic (and be sure to update PCLinuxOS first using the Reload, Mark All Upgrades, Apply method). This package is the first entry (as of this writing) in the Emulators section of Synaptic. Double click on aqemu to select the package (and any dependencies), then click on Apply in the toolbar to install AQEMU.
Once installed, AQEMU can be launched by selecting More Applications -> Emulators -> AQEMU from the system menu. When you launch AQEMU for the first time, the following will appear:

Click on Next here as there really is nothing to select (unless you want to use AQEMU in another language).

A hidden folder was created in your home directory called .aqemu. This folder is where virtual machines are created and maintained by AQEMU.
While running QEMU with a command line, you can control disk devices by accessing the QEMU command line. To access that command line, press Alt-2. To return to the virtual machine while running the command line, press Alt-1. For these commands, hold down the Alt key and type either 1 or 2 on the typewriter portion of the keyboard, not the numeric keypad.
AQEMU makes this easier by providing a Device Manager. Click on Use Device Manager to enable this feature. You may also enable this feature later while running AQEMU.
The embedded VNC display is not fully functional at this time, so I do not recommend selecting this option.
Click on Next to get to the next screen.

Here, we click on Search to allow AQEMU to find any implementations of QEMU.

Obviously, both QEMU and KVM are available when we installed QEMU itself from Synaptic. KVM stands for Keyboard, Video and Mouse and requires a special kernel driver that directly accesses the named devices. (Unfortunately, the KVM driver here does not work if you also have VirtualBox installed because of the drivers from VirtualBox conflict with KVM.)
Also, the developers of AQEMU need a lesson in proper grammar as we can see with the messages. These messages should read:
Found QEMU in /usr/bin, version: QEMU 0.12.x
instead of Finded QEMU in /usr/bin... as displayed above.

Now, AQEMU is ready to use. Click on Finish to begin.

This poorly worded message tells us that we need to select default versions of QEMU and KVM to use for running virtual machines from within AQEMU.
If you ask me, this message should have been worded to read “No default QEMU emulator has been selected!”

Finally, we get to the main window where virtual machines are created (and a correctly worded message telling us to create a new virtual machine). Note, the settings that were discussed in earlier articles are available in easy to find tabs shown in the window.
Now, let us select the default emulators AQEMU will use for running QEMU.
From the top menu, select File -> Advanced Settings to choose the default emulators.

For each entry select the entry, then click on Use Default to use the emulator binaries.

Click on OK to select the installed binaries so AQEMU can use the emulator binaries with virtual machines.
General Settings
Selecting File -> General Settings pulls up a list of options we can use with AQEMU.

Here is where we can enable the device manager controls that were discussed earlier in this article. These controls can be included within the virtual machine window itself, or in a separate window.
AQEMU supports only x86 and x86-64 architectures for virtual machines. There are templates containing presets for virtual machines running Linux 2.0, 2.4 and 2.6 (32-bit and 64-bit), FreeBSD (4 and later), Windows (Versions 2000, XP, Vista, and 7) and Mac OS-X (32-bit only).

The File menu allows us to create or convert disk images, just as we can with the qemu-img command.
The Run First Run Wizard is used to reset AQEMU if for some reason things get botched up while running AQEMU.

The VM menu is the “meat and potatoes” of what you can do with AQEMU. Most every function you can access in AQEMU is launched from this menu.
When you launch AQEMU the first time, there are no virtual machines setup. What we need to do is to add a new virtual machine. The New VM menu comes with three submenu items, namely one to load a virtual machine from a virtual machine configuration file, one to create a new virtual machine, and the Wizard. The latter is the easiest way to create a new QEMU virtual machine. You can also activate the Wizard by holding down the Control key and typing W.

Obviously, we want to click on Next to get started.

Most of us will want to choose the default option (Typical) which configures the virtual machine with common options. Selecting Custom allows you to customize the virtual machine created by AQEMU.

For PCLinuxOS, I recommend selecting QEMU for full x86 machine emulation.

Here is where we create the configuration file for the virtual machine. AQEMU uses configuration files (called templates) so the virtual machine will be properly configured when it comes to networking, disk images and hardware.
By default, we can install a Linux distribution with a 2.6 kernel. Of course, there are other operating systems that can run on an x86 processor. AQEMU contains templates for:
The inclusion of a template for Mac OS-X is controversial at best as there is no guarantee that Mac OS-X will work on QEMU at all. Even if it did, the end user license states that Mac OS-X is to be installed only on Macintosh systems, and hence the use of Mac OS-X here would violate Apple's license agreement.
The Generate VM option allows us to create a new template for the virtual machine. Here, we can create virtual machines for all hardware platforms supported by QEMU itself.

There are two parameters we can select from drop down menus. The first sets the processor type the emulated machine will implement. Release Date is used to tell AQEMU which generation of machine you wish to emulate.
For our first virtual machine, we shall use Linux 2.6 with the typical setting. For a Linux 2.6 machine, the machine type is a 32-bit x86 machine built between 2005 and 2010.

By default, AQEMU allocates a virtual disk for our new virtual machine. We can change the size of the disk. The virtual disk is created, but no space is allocated to the disk until we format it from AQEMU.


Of course, we will need to enable networking to run Linux.

...and that is all there is to it. We have created a new virtual machine using AQEMU.

Now, the details of our new virtual machine appear in the main window of AQEMU. We have a 32-bit x86 machine with 256MB of system RAM, an unformatted hard drive, and a network adapter. As configured, the virtual machine will attempt to boot Linux from a CD/DVD image, which has not been defined just yet!
Any changes to the virtual machine configuration do not take effect until we click on Apply.
We click on the General tab and get the following:

The audio card emulated here is the Esoniq (Creative Labs) ES1370, though we can change this to a Creative Sound Blaster 16, a Gravis Ultrasound GF1, or an Intel 82801AA based audio board.
If you have sufficient memory in your system, you can also increase the amount of memory allocated to QEMU. For modern Linux distributions such as PCLinuxOS, you will need to have at least 512MB of memory allocated.
The HDD tab shows the current configuration of virtual hard drive images. Click on Format to allocate disk space. It is there you will need to specify how much memory to allocate to the virtual disk.

The CD/DVD/Floppy tab is where we assign a CD/DVD image for QEMU to boot Linux from.

Click on CD/DVD-ROM and then click on All Settings.

Here, we can specify parameters to use with the emulated CD/DVD-ROM drive.
File: This is the name of the disk image or actual device name (such as /dev/cdrom or /dev/sr0).
Interface: This is the type of disk controller interface to emulate. By default, the disk controller is an ATAPI/IDE interface. We can also change this to a SCSI interface is we wish. (Some early CD-ROM drives connected through a SCSI controller rather than a IDE controller.)
Index: If an IDE interface is used, this indicates the controller number (starting with the number 0 as opposed to starting with the number 1.)
Bus: If we are using a SCSI interface, we must specify the bus and unit numbers (also starting each with the number 0).
Media: Since we are using a CD/DVD image, we need to specify CD-ROM instead of disk, hence telling QEMU that this is a read-only device rather than a read/write device.
Boot: Select this to allow QEMU to boot from the CD/DVD image.
Let us close this dialog box. Now, when we open the drop down menu, we get a listing of device names representing physical CD/DVD devices. This is useful when we plan to use a physical CD/DVD-ROM containing the operating system. To the right is a button that opens a file chooser where we can select a CD/DVD image file.
For an example, let us use pclinuxos-kde-fullmonty-2012-09.iso, which is the disk image for the Full Monty edition of PCLinuxOS (the latest available as of this writing).

Click on All Settings to set parameters.

Next, click on All Settings, then click on Boot, and select on, then click on Interface and select ide, then click on Media and select CD-ROM, finally click on OK to tell QEMU to boot Full Monty at startup.
Next, we select the Network tab.

The default network card emulated for QEMU is Intel's E1000 adapter. PCLinuxOS supports all the network cards emulated by QEMU, so we can select any adapter from the following:

Next, we select a connection type. For this, we shall choose User Mode Network Stack.
The button to the right of the MAC Address generates a random address assigned to the emulated network card. This is the hardware address used by the guest operating system to configure its networking services.

Be sure to click on Apply to make the configuration current. We are now ready to launch our virtual machine. Hold down Control and press S to launch QEMU.

We have just setup a virtual machine using a graphical interface. AQEMU is one of the easiest (and most intuitive) ways to run virtual machines with QEMU.
How To Add A System Command
by Gary Ratliff, Sr. (eronstuc)
Well it has been quite a while since I last wrote. Since I am getting to be an old man, I have been thinking about getting my last things in order. Also, since I had never used Wine, I decided to learn a bit more about it.
Then I realized that most of the things I enjoy about computing were related to writing software. I also looked through my library to discover that the language which I have the most on is the C++ language.
In this library, I learned that two of the volumes contained CD's which had a free development system called Dev-C++ from Bloodshed Software. I also ordered the CD for this, which has the linux version of this development package. OK … so I also learned that it seems to take forever to get the people to send the item. The system is not really in current development and has not had anything added to it since 2005.
One of the features of this package for Windows is a command: system(“PAUSE”) which ends most of the programs developed for a console application. This is because when Windows executes these programs, it will just execute the code and return to Windows! So the PAUSE command stops the system so the user can see the output of the program.
Now if we use g++ and Linux, we don't have that problem, since the program is mainly launched from a terminal and its output is clearly visible.
However, I thought that it would be a challenge to develop a PAUSE system command which would perform the same as this feature of the Dec-C++ package.
The output from this is simply a message which writes: “Please press any key to continue” and then waits for the user to press any key.
After much study in the methods of the cin object, I learned that the single character get feature was just the thing we needed. Once the PAUSE feature was created, we would want to add it to the system path. To do this, we need to be root or the action will be denied.
Therefore, I will show you how to add this to your system programs. I will be using a freshly installed version of Full Monty which I made to a flash drive from my computer Gabriel (the eMachine I bought last Christmas). So learn where the system files are kept. To learn this execute the command:
which g++
and on the Full Monty, the answer returns as /usr/bin/g++.
Therefore, we know that the pause command will have the location/usr/bin for its home once it has been created.
After some experiments which went awry, this C++ program was found to work correctly. We will use the Kwrite editor to create the following program. So launch it with kwrite get.cpp and enter the following program:
#include <iostream>
using namespace std;
int main()
{
char ch;
cout << “Please press any key to continue.... “;
ch = cin.get();
return 0;
}
Now save the program and remember that all these steps are performed as the root user. We are now back in a terminal and ready to compile the program with this command:
g++ get.cpp -oPAUSE
Next, you may test it to verify that it works correctly using:
./PAUSE
and the message is shown to the terminal and vanished once you press any key. You are now ready to save the program as a new system file with:
mv PAUSE /usr/bin
Now the program is on the path and will run if you enter the command PAUSE. So now we want to use the new feature of allowing the line:
system(“PAUSE”) to be a part of our C++ programs.
To test this, we will use the tried and true Hello World program. By the way, once this has been installed on the system path, there is no longer the need to remain root.
OK. Let’s enter the infamous Hello World program once again using the kwrite editor from the command: kwrite hello.cpp and then enter the following program:
#include <iostream>
#include <cstdlib> // or #include <libstd.h>
using namespace std;
int main()
{
cout << “Hello World!” << endl;
system(“PAUSE”);
return 0:
}
We finish up by saving the program and then compile it using:
g++ hello.cpp -ohello
(or just g++ hello.cpp and the default output will be named a.out.)
Now we launch it with ./hello or ./a.out and see the result:
Hello World!
Please press any key to continue....
The cstdlib or the stdlib.h file is needed to allow you to use the system command. The endl object is needed to force a newline to the text Hello World. If you leave off the endl then the message: Press any key to continue is printed before the message Hello World. I verified this on both the Full Monty and my Knoppix 6.4 computer and both have the same result.
Btw I have now used flash drives to store my linux systems as I am not anxious to loose an entire hard drive. The Full Monty may be installed on a 16 Gig flash drive and once installed will have 1.6 gigs of space available for you to use for your own data.

ms_meme's Nook: I Was Banned

No Passwords: SSH Authentication Using Authentication Keys
by AndrzejL
It would drive me bananas if I would have to remember password for each and every of my shell accounts… leaving the account with no password is unacceptable however from the security point of view. Solution? Use authentication keys – public and private.
How to get them? Its very easy.
Open terminal on Your local machine.
Use command:
ssh-keygen -t rsa
When asked for:
Enter file in which to save the key (/home/mylogin/.ssh/id_rsa):
Press [ENTER].
Enter passphrase (empty for no passphrase)
Press [ENTER].
Enter same passphrase again:
Press [ENTER].

[mylogin@myhostname ~]$ ssh-keygen -t rsa
Generating public/private rsa key pair.
Enter file in which to save the key (/home/mylogin/.ssh/id_rsa):
Created directory '/home/mylogin/.ssh'.
Enter passphrase (empty for no passphrase):
Enter same passphrase again:
Your identification has been saved in /home/mylogin/.ssh/id_rsa.
Your public key has been saved in /home/mylogin/.ssh/id_rsa.pub.
The key fingerprint is:
xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:7b mylogin@myhostname.local
The key's randomart image is:
+--[ RSA 2048]----+
RANDOM ART
BLAH
BLAH
+-----------------+
[mylogin@myhostname ~]$
So, what did you do so far? You have generated a pair of authenticating keys. Private, which is for your eyes only, and public, which can be shown to anyone.
The keys are placed in those two files:
Your identification has been saved in /home/mylogin/.ssh/id_rsa. <<< PRIVATE KEY
Your public key has been saved in /home/mylogin/.ssh/id_rsa.pub. <<< PUBLIC KEY
Run this command:
cat /home/mylogin/.ssh/id_rsa.pub
Lets say it spits out this:
ssh-rsa AAAAB3NzaC1yc2EAAAADAQABAAABAQCwMplVCQ+Y33n4kTVAy0nQReGD1GXmM28/D4STzNwdEthSY9UGIBduS1dGIVLWZYnphZglNFHE0Z0eIqgo0o0GDdtxqqsV20Zq/KV2nN+E8axlin4mRNuc/HgczxXkOtqkS9/yENOq8XN7XPD57kC+v+017GGNh139WiHbw+Myn9/mamjhmjywcnReiIbrYZnlgWJjpCXJCEoQZczypUyzB6x7aUMlenGdZwtfXCEPP709VSP9lUzanosY6bq1XoF6ravL2fulAvuNQVyxL7nfqJsio0JCI400WEJYm1et8Eg2vVEtIgIEKS7DZou/DR++/QgXpQas6yxaaHQ6Q0wt mylogin@myhostname.local
Now copy this ^^^ ENTIRE line.
Now that You have generated authentication keys and copied the public one – You have to place the public key in a file on the remote machine. Not just any file. Its a specific file in a specific folder both with a specific permissions.

Open new terminal. Ssh Yourself to the remotemachine.net
ssh -l mylogin remotemachine.net
Create directory in .ssh in Your home folder
mkdir ~/.ssh
Give it correct permissions:
chmod 700 ~/.ssh
Create file authorized_keys in the newly created directory
touch ~/.ssh/authorized_keys
Give it correct permissions:
chmod 600 ~/.ssh/authorized_keys
Paste the content previously copied from the cat /home/mylogin/.ssh/id_rsa.pub command combined with
echo "PASTE" > ~/.ssh/authorized_keys
Example:
echo "ssh-rsa AAAAB3NzaC1yc2EAAAADAQABAAABAQCwMplVCQ+Y33n4kTVAy0nQReGD1GXmM28/D4STzNwdEthSY9UGIBduS1dGIVLWZYnphZglNFHE0Z0eIqgo0o0GDdtxqqsV20Zq/KV2nN+E8axlin4mRNuc/HgczxXkOtqkS9/yENOq8XN7XPD57kC+v+017GGNh139WiHbw+Myn9/mamjhmjywcnReiIbrYZnlgWJjpCXJCEoQZczypUyzB6x7aUMlenGdZwtfXCEPP709VSP9lUzanosY6bq1XoF6ravL2fulAvuNQVyxL7nfqJsio0JCI400WEJYm1et8Eg2vVEtIgIEKS7DZou/DR++/QgXpQas6yxaaHQ6Q0wt mylogin@myhostname.local" > ~/.ssh/authorized_keys
Logout from the remote machine:
exit
Log back in.
ssh -l mylogin remotemachine.net

Remote ssh server shouldn’t ask for a password. If it does – You messed up and You are reading it all tagged as FAIL!
You can use 1 private key to connect to multiple servers. Just copy the public key to all of them like I explained above. Permissions are crucial. 700 for the .ssh folder and 600 for the authorized_keys file. 99% of errors are connected to the wrong permissions of the folder / file or due to the wrong file name.
Testimonials
from Tovian
Hello. I am a newbie. Not to computing, but to Linux. I've been working with computers of one sort or another since 1973. A little over a year ago I decided to expand my current horizon beyond the Windows world and have a go with Linux. I was actually looking for a better "file server" solution for small "Windows" (P2P) networks. I got involved with another version of Mepis - oops, I meant to say another version of Linux - and really learned a lot. But it was a difficult time for someone with no Unix/Linux background. Nevertheless, what I learned during the last year made me truly appreciate how easy and solid this PCLinuxOS really is.
I am still running three to five Windows boxes on the same network with this Linux box - and I have a one-man computer-support business with all Windows clients - but I am doing more and more with Linux. I am already having fun with it again. In just three days I've accomplished more on this OS than I did for months with the other one. I'm not saying the other one is bad - it's just that this one is so much easier to deal with. It’s much more user-friendly - and - things that are supposed to work actually DO work.
I'm looking forward to learning a lot more about Linux - and I already have a good feeling about PCLinuxOS.
From nitrogen_widget
I switched to the latest KDE build, imported all my email, my docs & everything else. Since I used Thunderbird and OpenOffice, it just took an add-on to import all my email & with LibreOffice, nothing had to be done. With Chromium, I just log into Google & import my bookmarks. With Picasa and Dropbox, it's all good.
Eventually I'm going to want to get back to D3 and WOW's expansion next month is sure to break under Wine, but honestly I just don't miss Win7 at all. KDE has enough eye-candy and the repo pretty much has an equivalent or a Linux version of what I was using, so the whole thing was fairly seamless. The boot speed & the speed of the PC is faster also.
PCLinuxOS - KDE 4.8 isn't the second coming or anything, but neither was Win7. I actually went back to my XP install for games just because the Win7 install takes up so much more space.
I've never gone this long off of Windows (at home) before. I have to use it at work.
Oh, my Mom has been on the Openbox version for the last yr on her P3 with 512mb ram. I might upgrade her to LXDE Mini because I haven't updated her system at all since I gave it to her.
Thanks for the great distro.

From David Cornelius
Hi all!
I admit I'm a Windows developer, but I was raised on the command-line in DOS days and Linux shell scripts have never scared me off. In fact, I still use vi quite often. Yes, I know Windows inside and out, but am bound and determined to increase my knowledge and use of Linux. In fact, I can now honestly say that I have more Linux machines at home than Windows. But that mostly because I've recycled some old laptops that were choking with Win XP but now run fine with Linux.
I like using a different flavor of Linux on each machine so I can really learn the differences between them and figure how to get around on any Linux system, no matter where I am. My oldest and slowest machine runs Lubuntu (LXDE), an old laptop runs DreamLinux with Xfce, I have a server with a popular distribution that this forum software refuses to acknowledge (hint: it starts and ends with a "U"), and an XBMC machine I plan on hooking up to an HDTV soon.
But my biggest and newest Linux machine, which sits right next to my Windows 7 development machine, runs PCLinuxOS Full Monty with KDE4! Of all the distributions I've played around with, I keep coming back to PCLOS because it works so well. And from what I can tell, the community here is great and there's plenty of documentation. How many distributions have their own monthly magazine?
I'm from the Portland, Oregon metro area and have lived in the Pacific Northwest all my life. My day job involves writing applications and plug-ins to support a Windows retail Point-of-sale system. My weekend hobbies including hiking in the beautiful Columbia River Gorge or the nearby Cascade Mountains.
Anyway, I will poke in here from time to time and hope to get to know some of you a little better.
From Lutz1948
Another newcomer...
Hello to everyone, and thanks to all guys and girls who made it possible that I can easily jump onto the running train! Or lay myself comfortably into the ready made bed, with most problems already solved by others.
My name is Lutz, and I was born in the first half of the last century. I am not an absolute first-time user to Linux, since some years I sniffed a bit here and there, but always jumped back to the more familiar system, or better to say, to the familiar applications, when I wanted something to be done fast.
And I am not even an absolute newbie to PCLinuxOS, I have in mind to register to this friendly forum already since one year or more. My problem, believe it or not, was to find a sign-in name fit for me old newbie! Well, this problem is SOLVED!
Minutes before I registered today I felt a bit ashamed, when I got to read about the closure of the PCLinuxOS Magazine forum. Surely I could have participated a little, telling others about MY long way to Linux. However, this magazine is highly appreciated, I have all the PDF's back to 2006-09 orderly saved to a separate folder. And also I read the magazine, at least what is of interest for me.
Last but not least I have to thank Hero-Member “Bicolano”, who more than one year ago stopped his car beside me, and with the words “Good to meet you, I have something for you!” handed to me the newest PCLinuxOS Live CD! Nevertheless, when on this CD I could not find my favorite Opera-Browser, and then did not know yet how easy it is to install. I preferred to download Full Monty instead (which, using my slow 3rd-world Internet connection took me some days).
Too many words already for a newcomer, who basically has not much to say. My ups and downs using Linux together with another system could fill some pages.
After some major hardware changes both XP and Win7 could not find ANY of my 3 hard drives, while Win98 could see a large drive, but did not know about NTFS, and FAT 16 did not like the size of the partition... Sure, I knew about that, but had to be reminded first by try and error.
However, here I am, since about one month Windows-free!
Kind regards to everyone.
From auxe
Hi everyone, I am really impressed with PCLinuxOS and completely new to it. I have always been a Windows user, but have become dissapointed with it.
When I bought my daughter a new build PC, I was waiting for The Windows 7 disk to arrive, so I installed Pclinuxos on it. It found all the hardware, and even found the drivers for an old Safecom USB wifi dongle. It worked flawlessly.
I have now tried the live cd 2012 on three desktops and three laptops, and it has worked perfectly! I installed it on a small dell pentium 4 with 1 gig of ram and it runs far better than with the previous OS, with YouTube at 720 HD it was flawless! Its actually a very usable computer again, unlike its previous OS, which could barely display any youtube without the swapfile going crazy. It seems a much lighter OS.
Hats off to you guys for making such a great OS!
I love the way it leads new users by the hand when installing, and the ease of using the synaptic installer. I have tried two other distros, but they seem more interested in the newest versions of programs and not so interested in stability and getting the installation to work with lots of hardware. It just wore me out trying to get hardware to work because I am new to Linux and didn't have the time to devote to it.
Even my friends who usually say that Linux "is to time consuming and complicated to get all the drivers working" have been really impressed with Pclinuxos. Now they have installed it to! and are really gaining an interest in it.
I never thought I would see the day when I wouldn't be using Windows. But it looks like its here for me.
Really impressive! I can't imagine the amount of work it must take, but thank you!
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Table of Contents
Graphics Tutorials: Gimp, Part 4
October Is Breast Cancer Awareness Month
Search The PCLinuxOS Repositories From The Command Line
Forum Foibles: Featuring Furry Foibler joechimp
Mark's Quick Gimp Tip & Double Take
Customize Squid Network Warnings On PCLinuxOS
Graphics utorials: Gimp, Part 4
Create Your Own Custom KDE Service Menu
Forum Foibles: Featuring Functional Foibler JohnW_57
No Passwords: SSH Authentication Using Authentication Keys